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ACD SMR User's Guide Overview of the ACD SMR

Overview of ACD SMR

The SMR system is a monitoring tool used along with the Quadro Automatic Call Distribution (ACD) feature to monitor
the current statuses of the Agents on one or many QuadroM32x. The status values are stored in the database and are
used for generating the statistical reports for Agents and Agent Groups.

The SMR system includes the following components (Figure 1).
e The Database is a MySQL database used for storing the status data.

e The ACD service is a “Windows service” application that continuously monitors Quadro units, retrieves the

status and statistics data, and stores them into the MySQL database. The default TCP port of the ACD Service
is 4660.

e The SMR client application is a Windows application that retrieves data from the database for display. The
default TCP port for communication with the database server is 3306. One or more SMR clients can connect to
the database.

e Quadros are QuadroM32x units with the properly configured ACD feature.

Figure 1 SMR components

All components may be installed and run on the same PC. Alternatively, any or all of them can be installed on a
separate PC. The installation of each component is described below.

ACD Statistics, Monitoring, Reporting 3
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Setup and Configuration

MySQL Server

MySQL server is used for storing the status and statistical data obtained from Quadros. The following are the
requirements on MySQL server:

e MySQL server version 5.0.45 or higher.
e Basic configuration with the default port of 3306 for TCP connection.

e A database user that is privileged to execute Create, Insert, Update, Select, Drop, and Delete commands. If
the “root” user is to be used, ensure that the remote access for the root is enabled in MySQL configuration.

Installing MySQL Server
The following step-by-step instructions describe how to install the MySQL Server:

Please Note: The instructions below are not meant to be used as a comprehensive guide for the MySQL server. They
describe the minimum installation required for the operation of SMR. For more information on the MySQL server setup,
please refer to MySQL documentation.

i‘é‘- Mys(L Server 5.0 - Setup Wizard g il

Welcome to the Setup Wizard for MySOL
Server 5.0

1. Run the setup.exe for MySQL server. The Setup
Wizard will start. Click Next.

The Setup Wizard will allow vou to modify, repair, or remove
MySOL Server 5.0, To conkinue, click Mext,

= Back I Mexk = I Cancel |

Figure 2 Startup Page.

. L] i
2. Choose Typical when prompted for the setup type.  Eaata GRS AL - __x
Click Next, then Install. The installation process Setup Type
starts. Choose the sebup bype that best suits vour needs.

Please select a sekup bype,

* Typical
— Common program features will be installed, Recommended for
' general use,

" Complete

- All program Features will be installed. (Requires the most disk

—
b ¥ space.)

| o

" Custom

-4 Choose which program Features vou want installed and where they
v L will be installed. Recommended for advanced users.

< Back I Mext = I Cancel

Figure 3 Choosing the Setup Type.
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ACD SMR User's Guide Setup and Configuration

3. Once the installation is completed, the page similar — SEEEEEEETIES . x|
to the one shown in Figure 4 is displayed. Click the -
Next button twice. A MySQL Enterprise subscription is the most

comprehensive offering of MySQL database
software, services and support to ensure your

M l__l S Q L business achieves the highest levels of reliability,
security and uptime.

Enterprise An Enterprise Subscription indudes:

1. The MySQL Enterprise Server - The most reliable, secure, and up-to-date
version of the worlds most popular open source database.

2. The MySQL Monitoring and Advisory Service - An automated virtu
database assistant.

Mare ... | = Back | Mexk = I Cancel |

Figure 4 MySQL Setup Wizard - After Installation.
. L | =
4. On the next page of the wizard, select the E

Configure the MySQL Server now checkbox to
start the Configuration Wizard after the Setup
Wizard. Click the Finish button.

Note: If you skip the configuration, you can later
launch the wizard by selecting MySQL->MySQL

Server 509MySQL Server Instance Configuration Use this option to generate an optimized MySQL config
Wizard from the Start menu. R s e

W

MySolL

Wizard Completed

Setup has finished installing MySQL Server 5.0, Click Finish ta
exit the wizard.

¥ Configure the MySQL Server now

< Back I Finish I Cance|

Figure 5 Last Page of the Setup Wizard

Configuring MySQL Server

The following step-by-step instructions describe how to configure the MySQL Server:

MySQL Server Instance Configuration Wizard i 5'

1. On the startup page of the Configuration Wizard,

click Next. Welcome to the MySQL Server Instance

Configuration Wizard 1.0.8

The Configuration Wizard will allow wou to configure the
MySOL Server 5.0 server instance, To Continue, click
Mext,

-7

MySoL

Mexk = I Cancel |

Figure 6 Startup Page.
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Setup and Configuration

2. Choose Detailed Configuration when prompted

for the configuration type. Click Next.

3. Choose Developer Machine when prompted for

the server type. Click Next.

4. Choose Multifunctional

Database
prompted for the database usage type. Click Next.

MySQL Server Instance Configuration Wizard B 5'

MySOL Server Instance Configuration

Configure the My3SOL Server 5.0 server instance.

Please select a configuration type.

{+ Detailed Configuration

; 1§ Chaose this configuration type to create the optimal server setup For
' 3= this machine,

{~ Standard Configuration

U Use this only on machines that do not already have a MySQL server
o inskallation. This will use a general purpose configuration For the
server that can be tuned manually,

< Back I Mext = I Cancel |
Figure 7 Choosing the Configuration Type.

MyS0L Server Instance Configuration Wizard i =l

MySOL Server Instance Configuration

Configure the My30L Server 5.0 server instance.

Please select a server kype. This will influence memory, disk and CPU usage.

{+ Developer Machine

y This is a development machine, and many other applications will be
run on it. MySOL Server should only use & minimal amount af
MEMary,

" Server Machine

@] Seweral server applications will be running on this machine, Chaose
! this option for webfapplication servers, MySQL will have medium
S5 memory usage.

" Dedicated MySQL Server Machine

1 This machine is dedicated bo run the MySOL Database Server, Mo
o 4 other servers, such as a web or mail server, will be run, MySQL will
utilize up ko all available memaory,

< Back I Mexk = I Cancel |
Figure 8 Choosing the Server Type

MySQL Server Instance Configuration Wizard 1 5'

MySOL Server Instance Configuration

when

Configure the MySOL Server 5.0 server instance.

Please select the database usage.

+ Multifunctional Database

3 General purpose databases. This will optimize the server For the use
of the fast transactional InnoDE storage engine and the high speed
MyISAM storage engine.,

{” Transactional Database Only

1 Optirnized For application servers and transactional web applications.
~——1_ This will make InnalE the main storage engine, Moke that the
WP MyISAM engine can still be used,

{~ Mon-Transactional Database Only

Suited Far simple web applications, monitoring or lagaing applications
A as well as analysis programs. Only the non-transactional MyISAR
storage engine will be activated.

< Back I Mexk = I Cancel |

Figure 9 Choosing the Database Usage
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5. Choose the drive and installation path for table = Xl
Space_ C||Ck Next. MySOL Server Instance Configuration

Configure the My3SOL Server 5.0 server instance.

Please select the drive for the InnoDB datafile, if you do nok wank to use the defaulk settings.
InnoDE Tablespace Settings

c

Please choose the drive and directory where the InnoDEB tablespace
should be placed.

Ic: j IInstaIIation Path ﬂ _|

rive Info

Yolume MName:
File: System: NTFS

B 59 SR Diskspace Used [ 204 GB Free Diskspace

< Back I Mexk = I Cancel |

Figure 10 Choosing the Drive and Installation Path

6. Choose Decision Support (DSS) / OLAP when  MESESEERERIEEIEIE
prompted for the number of concurrent MySQL Server Instance Configuration
connections to the server. Click Next. Configure the MySOL Server 5.0 server instance.

Please set the approximate number of concurrenct connections to the server,

{+ Decision Support {DSS)/0LAP
e Select this option For database applications that will not require a
high number of concurrent connections. A number of 20 connections
will be assumed,
" Online Transaction Processing (OLTP)

. Chaose this aption for highly concurrent applications that may have
~5% &t any one time up ta 500 active connections such as heavily loaded
weh servers,

~ Manual Setting
bé; Please enter the approximate number of concurrent connections,
{

.
‘' Concurrent connections: 15 X

< Back I Mexk = I Cancel |

Figure 11 Choosing the Number of Concurrent Users

7. Ensure that both Enable TCP/IP Networking and  saeaiCRio ey iam iy DL N Eol i
Enable Strict Mode checkboxes are selected. MySQL Server Instance Configuration
Leave the Port Number setting to its default Configure the MySOL Server 5.0 server instance.
values (3306). Click Next.

Please set the networking options.

|¥ Enable TCP/IP Networking
[' Enable this ta allow TCPYIP connections, When disabled, only local
1C connections through named pipes are allowed.

Port Mumber:

Please set the server SOL mode.

|¥ Enable Strict Mode

This option Farces the server to behave more like a traditional
database server. It is recommended ko enable this option.

< Back I Mexk = I Cancel |

Figure 12 Choosing the Network Options

ACD Statistics, Monitoring, Reporting 7
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Setup and Configuration

8. Choose the Standard Character Set option when
prompted for the default character set. Click Next.

9. Ensure that both the Install As Windows Service
and Launch the MySQL Server automatically
checkboxes are selected and the Service Name is
set to MySQL. Click Next.

10. On this page of the wizard, enter the password for
the “root” user.

Please Note: Write down the specified password
on a piece of paper and have it handy when
configuring the ACD service and the SMR client
applications.

11. Select the Enable root access from remote
machines if the ACD service is to be installed on

a separate machine.

12. Click Next, then Execute. Once the specified
configuration is created, click Finish. The MySQL

server is now ready for use.

MySQL Server Instance Configuration Wizard

MySOL Server Instance Configuration

Configure the My3SOL Server 5.0 server instance.

Flease select the default character set.

+ standard Character Set
Makes Latinl the default charset, This character set is suited For
Endglish and other Wesk European languages.

{~ Best Support For Multilingualisn
Make UTF& the defaulk character set, This is the recommended
character set for storing text in many different languages.

{~ Manual Selected Default Character Set / Collation

Please specify the character set ko use,
Character Sek: Ilatinl hd l

x|

I Mexk = I

< Back

Cancel

Figure 13 Choosing the Default Character Set

MySQL Server Instance Configuration Wizard

MySOL Server Instance Configuration

Configure the My3SOL Server 5.0 server instance.

Please set the Windows options.

[V Install As Windows Service
"t This is the recommended way ko run the MySOL server

a8
@ on Windows.,

[ Include Bin Directory in Windows PATH

Check this option ka include the directary containing the
server | dient executables in the Windows PATH variable
50 they can be called from the command line.

Service Mame:

IMySQL v[

¥ Launch the MySQL Server automatically

x|

I Mexk = I

< Back

Cancel

Figure 14 Choosing the Windows Options
x|

MySQL Server Instance Configuration Wizard

MySOL Server Instance Configuration

Configure the MySOL Server 5.0 server instance.

Please set the security options.

¥ Modify Security Settings

3 §

Mew root password: [k

Confirm: ok

Enter the rook password.

Retvpe the password.

¥ Enable root access from remote machines

[ Create An &nonymous Account

2

This option will create an anonymous account on this server, Please
note that this can lead bo an insecure syskem.

I Mext = I

< Back

Cancel

Figure 15 Specifying the Password

ACD Statistics, Monitoring, Reporting
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ACD Service

The ACD service retrieves the status and statistics data from the Quadro and stores them into the MySQL database.
The successful configuration of the service, should allow it to connect to the database and Quadro units.

Installing ACD Service

To install the ACD  Service, run the
acdservicesetup.exe executable file and follow the
instructions of the ACD Service Setup Wizard until the
last page is reached.

{5 Setup - ACD Service =100 x|

Completing the ACD Service Setup
Wizard

Setup hasz finished inztalling ACD Service on your computer.
The application may be launched by selecting the installed
ICans.

On this page, ensure that the Configure ACD Service
checkbox is selected and click the Finish button.
Selecting the checkbox will launch the ACD Service
Manager, which is used for configuring the ACD
service. The Manager can later be launched by
selecting Epygi Technologies>ACD Service>ACD
Service Manager from the Start menu.

Click the Finish button to launch the ACD Service
Manager.

Click. Finish to exit Setup.

V' Corfigure ACD Service

Figure 16 Completing the Setup Wizard

Configuring ACD Service
Once the ACD Service Manager (Epyagi |~ acdservicemanager

I

Technologies>ACD Service>ACD Service ~ Configurations
Manager) is run, it opens the dialog box shown is
Figure 17.
—Selected connection status
Add Edit: Remove Apply Hide

Figure 17 The ACD Service Manager

ACD Statistics, Monitoring, Reporting 9
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To configure the service, click the Add button and specify the following Add/Edit ACD configurations x|
settings:

~ACD
Quadro TP |192.168.?4.39

e Quadro IP and port: The IP address of the Quadro whose
Agents should be monitored and the communication port. You

may leave the default value of 4660.
Part I"fE'E":'
e Server: The IP address or hostname of the MySQL server. If
the ACD service is running on the same PC as the MySQL
. —MYSOL
server, leave the Server setting to localhost.
Server I localhost

e User and Password: The “root” user on the MySQL server with
appropriate privileges and the password specified in step 10 of User Iru:u:ut
the section on Configuring MySOQL Server.

*kk
The Reset DB button on this dialog box removes all entries for the st I |

select Quadro from the database. ReseEDB |

Once the required settings are entered, click OK. The specified Quadro

will appear in the Configurations box (Figure 19). e |

Repeat this step for all Quadro units that should be monitored.

Figure 18 Specifying the Connection Settings

To edit the settings of the added Quadro, select the =
Quadro in the Configurations box and click the Edit ~ Configurations
button.

AC0(172.30,3.1 ¢ 46600 -= MYSOL (ocalhost 3306 )

To remove the Quadro and thus stop monitoring it,

select the Quadro in the Configurations box and click ACD (172.30.0.1 ; 4660) -> MYSQL (locahost : 3306 ) ‘>
Remove.
ACD (172,30,70.70 : 4660) - = MY3QL (192,168.70,18 : 3306 ) ’
a =l

r—Selected connection status

I Quadro connected, Database connected

Add | Edit Remove | Apply I Hide |

Figure 19 The Configurations Box

Once you completed specifying the list of Quadros, click < acdservicemiatianss X
the Apply button. The message informing that the ACD ~Configurations

service restarted will pop up. Click OK. B R e s 4}

If the ACD service successfully connects both to a [caserviii - |
Quadro and the MySQL server, it will show two linked ACD (172:30.0.1 : 4660) > ' <
triangles filled with green at the end of the entry line. The ﬁ Service restarted

left triangle shows the connection state with the Quadro, AL 00RO ! ’
and the right triangle indicates the connection with ok | i
MySQL. In case of a connection failure, the triangles will ~Selected connection stakus

be filled with red. Please check your network settings | Quadro connected, Database connected

and ensure you have specified the correct connection

Settings. Add | Edit | Remave Apphy | Hide

Figure 20 Restarting the Service

Please Note: If ACD service is running on a PC outside the Quadro LAN, then an appropriate port forwarding
configuration is required on the Quadro. This can be done by selecting Internet Uplink 2> Filtering Rules = Incoming
Traffic/Port Forwarding on the Quadro and adding a record for MySQL service pool. For more information on the
adding a service pool, please refer to Quadro’s Online help.

To close the ACD Service application, click the Exit button. Note that the service continues running. You may also
choose to “Hide” the application, in which case it will be minimized to system tray and will indicate the connection state
with the MySQL server and the highlighted Quadro.

ACD Statistics, Monitoring, Reporting 10
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Setup and Configuration

ACD SMR Client

The ACD SMR client is used to retrieve the data from the database and display it to the user.

Installing the ACD SMR Client

To install the ACD SMR Client application, run the acdsmrsetup.exe executable file and follow the instructions of the

Setup Wizard until the last page is reached (Figure 21).

On this page, ensure that the Run SMR checkbox is
selected and click the Finish button. Selecting the
checkbox will launch the SMR client application. The
application can later be launched by selecting Epygi
Technologies>SMR->SMR from the Start menu, which
is the default installation path.

]@ Setup - Statistics, Monitoring and Reporting

Completing the Statistics,
Monitoring and Reporting Setup
Wizard

=10x]

Setup has finished instaling Statistics, Monitoring and R eporting

on your computer. The application may be launched by
selecting the installed icons.

Click. Finizh to exit Setup.

¥ Run SMA

Configuring the ACD SMR Client

Figure 21 The Last Page of the Setup Wizard

On launching the ACD SMR Client application the Connect to MySQL Server (Figure 23) dialog box pops up. The
dialog box is used for creating new connections and managing the existing ones.

To create a new connection, follow the steps below:

1. Click the New button, specify a name for the connection and click Yes
(Figure 22). The connection will appear in the Saved Connections
drop-down list.

Mame:

x|

| Coonection ko ACD DE

es Mo

Figure 22 Creating new connections

2. In the Host Address text box, enter the IP Connect ko MySQL Server

address or host name of the PC where the
MySQL server is running.

vl

ACD

©cpys

3. In the UserName and Password text boxes
enter the user settings specified in step 10 of
the section on Configuring MySOL Server.

4. Click the Connect button. You'll be prompted to
save the connection settings. Click Save.

.
e | Save | Delete I
Saved Connections: | Coonection to ACD DB |
Host Adress I localhost
UserMame I ronk
Password I bk

Connect I Cancel |

Figure 23 Connect to MySQL Server Dialog Box

On clicking the Connect button, the application tries to connect to the MySQL database server. If connected
successfully, SMR will download the list of Quadro units that are currently monitored (Figure 24).

ACD Statistics, Monitoring, Reporting
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5. From this list, choose the Quadro and click the OK button. =)

—ACD servers

The SMR client will start downloading the initial status and statistics information

for the selected Quadro from the database and populate its tables with that data 192.168.70.70
(see below). Depending on the network condition and database load, this may ey

take several minutes.

—Ackive

| 172,530,531

oK I Cancel

Figure 24 Selecting Quadro

ACD Statistics, Monitoring, Reporting 12
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ACD SMR User Interface

ACD SMR Client User Interface

After all the components of the ACD SMR system have been successfully installed and configured, launch SMR by
selecting Epygi Technologies>SMR->SMR from the Start menu (or if you have chosen to create a desktop icon in the
SMR Setup wizard, simply double click on the SMR icon). This opens SMR’s main window (Figure 25).

SR - root at 192.160.70.10

Fla View Optiors Help
A HE e

T e P — T
= &y G0 | M| 35 2 1] &
B oaum 00onzs
8 ::L: 0000.24| T
pired 000022
Az 000,21
A08 00:00:57
vy | 00056
:'\II‘. D —1 ﬂuou”
8 ANz 000053
A1l | (L]
s e .
B AlG || 00:0045 |
a a7 000004
B ME | ATIS | 100112 - |
Q@ G | Adi6] i 6:27] I
S U — —
8 A2 A2 223250
8 a2 300 ] l]- ol o D. l
= G301 | AllE | 000027 [
B A LAl 00.00.26
8 s Alz0 000025
8 M1% e 00.00.23|
e ::g L am 000022
8 412 | a1z | | 00.00.50
8 MM Al24 223250
8 an e e 006045
'E'm;‘” Az | | 00:00:51 |
& & 6 SR | 00,0004
v G S Alze 10:00:20
| AIE [ B 00057
AN 00.00:55
| AL3l 000054
AR 00.00:53 I 1
@o ol ol 9] 0 ol ] =
ACD Agerits || 8 Current stas [l Seatus stmtintics ] gl Cal statistics |
Resdy Connacted to MySOL datshace server: 19216870018 d upd hed {2009 55242 PM. End bmec4/1 7[2009 5:52:42 PM

Figure 25 The Main Window of ACD SMR

The main window of SMR client application is divided into the following areas:

Main menu

Toolbar buttons
Navigation window
Tab windows

Status bar

Main menu

The Main Menu is used for accomplishing common tasks, such as opening/closing a
connection with the MySQL database, selecting the timeframe for displaying statistical
data.

The toolbar buttons are shortcuts to the most frequently used menu items.
This window displays the navigation tree and allows the user to change the table views.
The tab windows contain the tables with the data retrieved from the database.

The status bar displays useful information on the application and the connection state. It
also displays the currently selected timeframe (on the right).

The main menu includes the following menus with their respective menu items:

File

Connect opens the Connect to MySQL Server dialog box, enabling the user to change/set connection
settings. (See the section on Configuring the ACD SMR Client).

Disconnect closes an established connection with the MySQL server. The menu item is active only if the
connection with the MySQL server has successfully been set up.

Change ACD Server opens the ACD server from the list dialog box, enabling the user to choose the Quadro
whose Agents/Agent Groups should be monitored. (See the section on Configuring the ACD SMR Client).
Export data- Exports the selected statistics data tables to CSV formatted files.

EXit closes the SMR client application.

ACD Statistics, Monitoring, Reporting
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View
e Toolbar shows or hides the toolbar
Status Bar shows or hides the status bar.
Show Graphics allows to show/hide the graphical bars in cells.
Display Agent displays the Agents’ IDs, Agents’ Names or both in Navigation tree, status and statistics tables
based on the chosen selection: "Display Agent ID", "Display Agent name" or both.
e Agent ID/Name length dfines the maximum allowed number of symbols in the Agent ID and/or Agent Name in

Current Status, Status Statistics and Call Statistics tables.

Options .
e Poll Rate opens the Poll Rate Rote (). [T
window (Figure 26), enabling the o | concel |
user to set a new value for the
Rate parameter. This parameter Figure 26 Setting the Poll Rate

specifies the rate (ms) at which the
active table data is updated from
information in the database.

e Timeframe opens a drop-down
list, enabling the user to choose
the timeframe for generating
statistical data. The possible
values for the timeframe are Daily,
Weekly, Monthly, and Custom.

The Custom option opens the x|
Customize Periods  dialog box where Period Start———————— PeriodEnd———————————————
the user can spemfylthe desired start StatTe: [Gosiorm = || EndTine [oosiomm o=

and end date time values for the
timeframe. Start Date: | 5/11/2009 ~] || Eerdpate: [spzizons 7]

Cancel I

Figure 27 Customize Periods Dialog Box

Help
e SMR Help invokes the SMR Help System.
e About SMR displays the current version of SMR and copyright details.

ACD Statistics, Monitoring, Reporting 14
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Toolbar Buttons
You can use the following toolbar buttons to easily access these menu items:

=) File>Connect

H File->Disconnect

fJ File->Change ACD Server
11|} Options>Poll Rate

Navigation Window

The Navigation Window displays the list of Agents and Agent Groups that AL ChLgE
are available on the selected Quadro. It also allows switching between two
table views. The data in tables can be viewed either by ACD Agents or by
ACD groups (Figure 28). When viewed by Agents, the navigation tree on
the left shows the Agents as main nodes and the groups they belong to as
sub-nodes. When viewed by Agent Groups, the tree displays the groups
as main nodes and the Agents they comprise as sub-nodes. To switch
between these views, click the respective button in the navigation window.

Figure 28 Selecting views

Tab Windows

All the data retrieved from the database is displayed in three tables in ACD SMR: Current Status, Status Statistics,
and Call Statistics. The tables are located on different tab pages and can be accessed by clicking the appropriate tab
page at the bottom of the form. The information on the currently active window is updated at a default poll rate of 5000
ms that can be modified from the Options menu. The detailed description of each of these tables is given below.

Current Status

The Current Status table shows the current status of Agents in a selected group. The table is organized in the
following way: table columns represent possible statuses an Agent may have and the rows represent Agents or Agent
Groups. For an Agent, a non-empty cell indicates the current status of the Agent and the time (h:mm:ss) since the
Agent is in that state. For Agent Groups, a cell indicates the number of its Agents that currently have the corresponding
status.

An Agent can have any of the following statuses.

e Online The Agent is logged in and is idle. It is available to accept calls.

e Offline The Agent is not logged in and cannot accept calls.

e Busy The Agent is currently on call

e Away The Agent is logged in but not available to accept the calls for a short time. To accept the calls

the Agent'’s status needs to be changed to Online either from the phone or from Quadro GUI

e DND The Agent is logged in but not available to accept the calls for a specified timeframe. When that
timeframe expires, ACD automatically changes the status of that Agent to Online.

Except for the Busy status, all other statuses can be changed from the phone or Quadro GUI. The same Agent may be
included in different groups and thus, it may have different statuses in different groups.

For Agent Groups, the table also shows the number of calls that are in the group’s call queue — the Calls in the Queue
Column. Note that this parameter is not applicable to Agents.

ACD Statistics, Monitoring, Reporting 15
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The ACD row at the top of the table indicates the total number of Agents in all groups that have the corresponding
status.

Figure 29 shows a screenshot of the Current Status window with the G300 Agent Group expanded. Fourteen Agents
in that group are currently online and the A110 Agent is in the Busy state.

00:03:;

00:03:06
00:02:59
00:02:42
00:02:30
00:02:13
00:02:01

- 00:01:52

00:05:02
00:04:45
00:04:33
00:04:16
00:04:04
00:03:57
00:03:35
14
14
15

15
14
1

ale|ols|eale

Figure 29 Current Status Page.
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ACD SMR User Interface

Status Statistics page

The Status Statistics page shows how long Agents have been in each of the five states for a selected timeframe
(Options>Timeframe). The value is expressed both in time units and as a percentage of total time. The filled
rectangles in cells are used to visualize the percentage. The cell values in blue indicate that the value has changed
during the last database poll.
For Agent Groups, cell values indicate the average values of Agent statuses for the Agent Group.
For ACD, cell values indicate the average value of statuses for all Agent Groups

Figure 30 shows a screenshot of the Status Statistics page.

. Onlime Offline Bus Ay DND
Bt Rtk (hh:un: ss) (hh:on: s5) (hh:mr::ss) (hh:r‘:mafss) (hh:an: ss)
ACD 00:43:02 (87.1%) 00:00:00 (0.0%) 02:00:56 (12.9%) 00:00:00 (0.0%) 00:00:00 (0.0%)
G300 | A3 | | 075025 (46.0%) 00:00:00 (0.0%) 09:11:24 (54.0%) 00:00:00 (0.0%) 00:00:00 (0.0%)
Al04 (| 125505 (97.6%) 00:00:00 (0.0%) 00:18:53 (2.4%) 00:00:00 (0.0%) 00:00:00 (0.0%)
AL0S 14:13:26 (97.8%) 00:00:00 (0.0%) 00:19:08 (2.2%) 00:00:00 (0.0%) 00:00:00 (0.0%)
A106 || 11:17.07 (86.5%) 00:00:00 (0.0%) | | | 0541:03 (33.5%) 00:00:00 (0.0%) 00:00:00 (0.0%)
ALY 12:58:59 (97.6%) 00:00:00 (0.0%) 00:19:05 (2.4%) 00:00:00 (0.0%) 00:00:00 (0.0%)
A108 12:51:05 (97.6%) D0:00:00 (0.0%6) D0:18:46 (2.4%5) D0:00:00 (0.0%) D0:00:00 (0.0%5)
A109 || 11:02:00 (64.9%) 00:00:00 (0.0%) | | | 055718 (35.1%) D0:00:00 (0.0%) D0:00:00 (0.0%)
ALLD 12:56:09 (97.7%) D0:00:00 (0.0%6) D0:18:38 (2.3%5) D0:00:00 (0.0%) D0:00:00 (0.0%5)
111 12:56:50 (97.7%) D0:00:00 (0.0%6) D0-18:27 (2.375) D0:00:00 (0.0%6) D0-00:00 (0.0%5)
Al12 | | 11:16:40 (66.3%) 00:00:00 (0.0%) | | | 054433 (33.7%) D0:00:00 (0.0%6) D0-00:00 (0.0%5)
A113 135744 (37.6%) D0:00:00 (0.0%6) D0:19:00 (2.47%5) D0:00:00 (0.0%) D0:00:00 (0.0%5)
Alld 135539 (97.6%) 00:00:00 (0.0%6) 00:18:40 (2.475) 00:00:00 (0.0%) 00:00:00 (0.0%5)
All5 | 11:08:07 (65.5%%) 00:00:00 (0.0%:) | 05:51:33 (34.5%) 00:00:00 (0.0%:) 00:00:00 {0.0%)
All6 13:01:56 (97.6%) 00:00:00 (0.0%) 00:19:30 (2.4%) 00:00:00 (0.0%) 00:00:00 (0.0%)
ALL7 13:06:59 (97.6%) 00:00:00 (0.0%) 00:19:22 (2.4%) 00:00:00 (0.0%) 00:00:00 (0.0%)
G300 :13:52 (85.7 00:00:00 (0.0%) 02:22:21 (14.3... 00:00:00 (D.0%) 00:00:00 (0.0%)
Gaol :28:06 (36.4 00:00:00 (0.0%) 01:54:50 (13.6... 00:00:00 (D.0%) 00:00:00 (0.0%)
G302 03:32 (84.6 00:00:00 (D.0%) 02:28:37 (15.4... 00:00:00 (D.0%) 00:00:00 (0.0%)
G303 11:35:25 (83.1... 00:00:00 (0.0%) 02:37:16 (16.9... 00:00:00 (0.0%) 00:00:00 (0.0%)
G304 12:19:28 (958... 00:00:00 {0.0%) 00:33:07 (4.2%) 00:00:00 (D.0%) 00:00:00 (0.0%)
G305 12:02:20 (93.7... 00:00:00 (D.0%) 00:48:02 (6.3%) 00:00:00 (0.0%) 00:00:00 (0.0%)
G300 03:18:20 (80.2... 00:00:00 (D.0%) 03:22:18 (19.8... 00:00:00 (D.0%) 00:00:00 (0.0%)

Figure 30 Status Statistics Page
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ACD SMR User Interface

Call Statistics

The Call Statistics displays the following information (Figure 31):
Applicable to both for Agents and Agent Groups:

Calls Answered — the total number of calls answered by an Agent/Agent Group within the selected timeframe.

Duration Avg. — the average duration of calls answered within the selected timeframe.

Avg. Queue Wait Time — the average time calls stayed in the queue before the Agent answered the call.

Applicable to Agents groups only:

Calls Received — the total number of calls received by an Agent Group within the selected timeframe.

Rejected (Overflow) — the total number of calls received by the group after the maximum Call Queue size has
been reached.

Rejected (Timeout) — the total number of calls received by the group and not answered within the ringing
timeout (Group Ring Timeout).

Calls Abandoned - the total number of calls received by the group and closed by the user before being
answered.

Avg. Abandon Wait Time — the average duration of calls’ wait time in the queue filtered for abandoned calls

only.

For the ACD row, the corresponding values are totals for all the groups.
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Figure 31 Call Statistics Page

Abardoned
| Cloged By Caller/Agent
| Rejectzd Teneout
Abandoned
Rejectsd Temeout
| Closed By Caller/Agent
| Cloted By Caller/Agent
| Closed By Callerffgent
| Cloged By Caller/Agent
| Clased By CallerfAgent
| Closed By CallerfAgent
| Closed By Caller/ Agent
| Clesed By Callerlfgent
[ Rejected Temeout
Fugjected Temeout

The table under the splitter includes the calls related information. The details are presented below:
Date/Time — call start time

Group — ACD group of agent answered the call

Caller IP — caller number (PBX, SIP or PSTN)

Called ID — agent number answered the call

Called Name- Called Agent name.

Time in Hold — time the call stayed in queue before being answered/rejected or canceled the call

Time in Live call — time of call duration with current agent

Close Reason - call's closed reason (Closed by Agent/Caller, Abandoned, Rejected Timeout)
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